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Testing PTP Slave Clocks

Proving PTP Slave Clock compliance as per
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ITU-T G.8261 is the International Telecommunication Union’s Recommendation
titled “Timing and Synchronization Aspects in Packet Networks.”

Appendix VI of ITU-T G.8261, “Measurement Guidelines for Packet-Based
Methods” provides the test methodologies to ensure that equipment is within
performance limits.
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Slave Clock compliance to G.8261 and provides procedures to measure the
output clock performance of such devices.
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1. Testing a PTP (1588v2) Slave Clock

The Paragon-X provides two methods for testing PTP Slave Clocks for conformance to the G.8261 defined performance limits.
e  Master/Slave Emulation mode — where the Paragon-X provides an emulated GM for the purposes of the test

e Non Emulation mode — where the functionality of the T-GM is provided by a 3rd party equipment

1.1 Master/Slave Emulation Mode — Equipment Required

e PTP Slave Clock (Device-Under-Test, DUT)
e  Common Stratum-1 (or better) GPS reference clock with frequency output (1I0MHz, 2MHz)

e  Accessories and cabling: BNC cables with T-splitters, RJ45 Ethernet cables, SFPs, matching single-mode or multi-
mode fibers

e  Calnex Paragon or Paragon-X including:

o  Option 201 Advanced 1588v2 features

o Option 250 |IEEE 1588v2 End-to-End — One-box BC, TC and OC
o  Option 205 Wander Measurement (Paragon-X)

o Option 206 Phase and Time Measurement (Paragon-X)

o Ethernetinterface rate options to match DUT

1.2 Non Emulation Mode — Equipment Required

e PTP Master Clock
e  PTP Slave Clock (Device-Under-Test, DUT)
e  Common Stratum-1 (or better) GPS reference clock with frequency output (I0MHz, 2MHz) and phase reference (1PPS)

e Accessories and cabling: BNC cables with T-splitters, RJ45 Ethernet cables, SFPs, matching single-mode or multi-
mode fibres

e  Calnex Paragon or Paragon-X including:

o  Option 201 Advanced 1588v2 features

o  Option 205 Wander Measurement (Paragon-X)

o  Option 206 Phase and Time Measurement (Paragon-X)
o Ethernetinterface rate options to match DUT



2. Paragon-X Physical Connections

Figure 1: Front Panel Connections
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The front panel of the Paragon-X provides different connections that can be used for testing:

1— Aux ports (RJ45)

For 1PPS measurements connect to the upper Aux port.

For the pinout, refer to the figure below; pin 1 will receive the measured input while the ground (or OV signal) is on

pin 2. The other pins are not used.

Pin4:
Pin 3:

Pin2:
GND

Pini:
1PPSIN

2 and 3 — 10G Ethernet ports.
4 — This connector is not used.

5 — Display.

Pin §:
Pin 6:

Pin 7:

I— Pin 8:

6 — In earlier versions of the Paragon, this connector is not used and does not supply USB power. In later versions it
supplies USB power to the External 1PPS/ToD Frequency Converter accessory.

7 — PC Controller (RJ45).
8 and 9 — 1GbE and 100M Ethernet ports.



Figure 2: Rear Panel Reference and Measurement Inputs to Paragon-X
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e 10 -- DC Power Input

e 11-- Power Switch

e 12 --1PPS Reference Input

e 13 -- Wander Measurement Inputs
o 2.048MHz (BNC)
o E1(2.048Mb/s) balanced (Bantam) or unbalanced (BNC)
o DS1(T1) (1.544Mb/s) balanced (Bantam)

e 14 -- Reference Inputs

10MHz (BNC)

2.048MHz (BNC)

E1(2.048Mb/s) balanced (Bantam) or unbalanced (BNC)
o DS1(T1) (1.544Mb/s) balanced (Bantam)

e 15 -- Reset Switch

e 16 -- 64K AMI Reference Input

e 17 -- GPS Reference

e 18 -- GPS Antenna Input (currently unused)

o O O

18 14



3. Master/Slave Emulation Mode

The Paragon-X Option 250 software enables the Paragon-X to act as an Emulated PTP Master as well as providing impairment
and measurement capabilities. Using this option allows the test to be carried out using solely the Paragon-X and the Slave

Clock under test.

3.1 Test Setup

Master

Impair

P 4

Capture

Physical connections
1. Connect Port 1 (Master side of Paragon-X) to the Slave Clock (Figure 1, connectors 2 or 3).

2. Connect the external reference, e.g. 10MHz, to the Paragon-X Reference Input (Figure 2, connector 14).

3. Connect the 1PPS output from the Slave Clock to the Paragon-X 1PPS measurement port (Aux). Use Calnex’s
1PPS/ToD/Frequency Converter accessory if required (Figure 1, connector 1).

4. Connect the frequency output (e.g. E1) from the Slave Clock to the Paragon-X frequency measurement port at the rear of
the Paragon-X (Figure 2, connector 13).



3.2 Application Setup

1. Select Setup Interface then Line Rate to match the Slave Clock under test.

File Imstrurnent(s) Setup  Capture
B @oo F§Ee

Start Up

Operating Mode

Setup Interface

Master{SlavefGPS
Emulation

Measurements

Select Flow

Configure Capture

Start Capture

Add Impairments}
Delay

Add Wander

2. Select the References tab to configure a stable reference for the Paragon-X. Set the Clock Source to External reference

Irmpair  Graph Data  Tools  Help

E G

Setup Interface

Ethernet | References MeasurementPDrtsITUD |

@) Ty+Rx Mode Thru Mode

Sync-E Clock R -= T

Coupled

Faort 1
Line Rate

T 100MbE @ 1GBE
Interface

@ RMS () SFR/SFR+

Aukn Negotiate

GBE Electrical Phy Settings

_I Farce Port 1
@ Master
@ Preferred

Fart 2
Line Rate

100MbE

Interface

5) RIS SFRISFP+

Auko Megotiste

(10MHz or E1/2MHz). An external source is recommended.

Eile Instrument(s) Setup Capture

Start Up

Operating Mode

’ Setup Interface

MasterSlavelGPS
Emulation

Measurements
Select Flow
Configure Capture

Start Capture

Add Impairmentsf
Delay

Add Wander

Packet
Generation
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Impair  Graph Data Tools Help

C ©

| Ethernet| References |Measurement Ports | ToD |

Clock Source
Ext, BNC Ext. Bantam

@ 10MHz _) T1ternary
) E1[ 2.048MHz _J Elternary

) Internal
1pps Reference Input
BNC GPS D-type @ Internal
Threshold: 1.6 ¥ (Range:0.5Vto 2.5V)
Termination:

External Wander Generation

Reference Output (Lower Front Aux Port)
10 MHz and 1pps

~ High Impedance @ 50 Ohm | i

Ext. D-type
) 6akb/s

[T Enable Wander Clock Source: | 10M wander meas BNC

1pps width: 20000 ps  {Range: 1to 500,000 ps)




3.3 Measurement Configuration

1. Click on the Operating Mode button then enable 1588v2 > Enable Master/Slave Emulation.

File Instrument(s) Setup Capture

=4 - o o

Operating Mode

Setup Interface

Master{Slave/GPS
Emulation

Measurements

Select Flow

Configure Capture

Start Capture

Add Impairments{
Delay

Tools  Help

Filter

I Cperating Mode

CES
@) 1583v2
/| Enable Master Slave Emulation
Services
Sync-E
NTP
Ethernet OAM (802, 1ag, ¥.1731)
MPLS-TP OAM (PTN based on Y.1731)

Close

2. Click on the Measurements button then enable the required measurement either (E71 or T1 or 2.048MHz) and 1pps Time

Error (Absolute).
File Instrument(s) Setup Capture
Bl @ e g

Start Up

Operating Mode

Setup Interface

Master{Slave/GPS
Emulation

Measurements

Select Flow

Configure Capture

Start Capture

Add Impairments{
Delay

Add Wander

Help

Filter

Configuration

/| Simultaneous Measurements and Impairments/Delay

Measurements
Sync-E Wander

Time of day

MNone
T1Wander
@ E1Wander
2.048 MHz Wander

MNone
'@ 1pps Time Error{Absolute)
1pps Time Error(Relative)



3.4 Preparing for Master/Slave Emulation

1. Select Master/Slave Emulation then choose Slave Test in the Test Configuration drop down menu.

Eile Instrument{s) Setup Capture Impair Graph Data Tools Help
SHoom FFENA ccem o DTN FE o6

Start Up

Operating Mode

Setup Interface

Master{SlavelGPS
Emulation

Measurements

Select Flow

Configure Capture

Start Capture

Add Impairments{
Delay

Add Wander

Packet
Generation

2. Now select which PTP Profile you want to use in testing the Slave Clock. The Paragon-X supports a number of pre-defined

profiles, including:

<< Results

Device Configuration ———
(@ Master + Slave
() Two Masters.
GPS Emulation

Configure

Calnex Paragon-X

Test Configuration

ve Test Master

o 1pps
General Purpose

Transparent Clock

Boundary Clock Capture Aocur
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Measurement ——————

["] Manual calibration
Calibration @

[[]set capture flow filter

° G.8275.1 Phase Profile (Multicast, Ethenet)

e (.8265.1 Frequency Profile (Unicast, IPV4)

e <) [ Gl

Mode: Unicast Auto

Connected Slave D-Reg| Sync | Ann
Address Rate |Rate |Rate
Mode: Unicast Auto
Connected Master D-Req| Sync | Ann
Address Rate |Rate |Rate
Port. Link Rx Packet

1@ @ GooD PACKETS

2 @ ©  GoOD PACKETS

3. Select which profile is supported by the Slave Clock using the Custom Profile drop down menu.

Test Configuration ———

el
et [0 @
e

Master —l1 pps

re Accul
FEa | @

1] Rx
Impairmenst [l Impairrment

1pps Meas,
cabile (nsy:

&+ Master

| Manual calibration

Calibration | -
Start: |

™| Set capture Flo filter:

Calnex Paragon-X

6.0275.1Phase Profe =] |
( file

1588-2008 Profile

802, 1A5 (QPTP)

C37.238-2011 Power Profile
C37.238-2017 Power Profile
Enterprise Profile

G.8265. 1 Freguency Profile
G.8275,1Phase Profile

G.8275. 2 PTS

‘Wander
Misas,



4. Enter the DUT to Paragon-X 1PPS cable delay.

To correctly calculate the 1PPS measurement, the delay caused by the cable connecting the Slave Clock 1PPS output and
the Paragon-X 1PPS measurement port must be removed. Values of 5.1 ns per 1 metre of cable can be used.

Start Up

Operating Mode

Setup Interface

Master!SlavelGPS
Emulation

Measurements

Select Flow

Configure Capture

Start Capture

Add Impairments
Delay

EGLRVETTE

Device Configuration ———
Master + Slave
) Two Masters

GPS Emulation
Configure

Test Configuration ———

DUT Ethernet
cable {ns): D

1pps Ref,
cable {ns):

Capture

Master
) Slave

() Rx on both

Measurement

[ Manual calibration

Calibration L

Master

G.8275.1PhaseProfie |

Calnex Paragon-X

1pps

Acur;
] acy

5. Start the Master/Slave emulation by clicking on the button highlighted below.

Eile Instrument(s) Setup Capture Impair Graph Data Tools Help

Sl ows FFEMER S COM o MW bB &0

Start Up

Operating Mode

Setup Interface

Master/Slave/GPS
Emulation

Measurements

Select Flow

Configure Capture

Start Capture

Add Impairments}
Delay

Add Wander

Packet
Generation

Statistics/
Results

Device Configuration ———
Master + Slave
() Two Masters
GPS Emulation

Test Configuration

DUT Ethernet

cable (ns): E
1pps Ref.

cable (ns); E

1pps Meas.
cable (ns): 0 ﬂ

Calnex Paragon-X

Capture
(@ Master

() Slave

() Rx on bath

Measurement
[[]Manual calibration

Calibration -

[]set capture flow filter

Apply changes

111
Mode: Multicast

B8)6)
Connected Slave D-Req| Syne [ Ann
Address Rate |Rate |Rate

Mode: Multicast

Connected Master D-Req| Sync | Ann

Address Rate |Rate | Rate

Port Link Rix Packet
18 &)  GOOD PACKETS
2@ & GOOD PACKETS

e RefLock e 1PPS Ref e 1PPS Meas
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3.5 Confirming PTP Traffic on the Interfaces

Check the link to make sure that the PTP packets are being exchanged without error. If working correctly, both Link and
Packet status indicators for port 1 will be green as shown below.

Port | Link | Rx Packet [
1@ &) GOODPACKETS
2 9 &  NOPACKETS

No Capture filters are required for testing the Slave Clock output, but it is good practice to ensure that the correct traffic is
being passed between the Paragon-X Master and the DUT before starting a measurement.

Connect the Slave Clock and clock outputs as detailed earlier in this document. With everything connected, start the

Start Capture

Paragon-X Emulated Master running, then perform a capture using the button. This will capture PTP
packets between the Master and the Slave Clock and the clock outputs from the Slave Clock.

Master/Slave/GPS

Emulation

Stop Capture | DAF‘TUFEE 1EEEv2

Add Impairments{
Delay

Add Wander

Packet
Generation

3. To check the clock’s frequency output use the pull down menu:

CAPTURE - EUT1

CAPTURE - E14T1
CAPTURE - 15882
CAPTURE - 1pps/GP
CAPTURE - E1/T1

"



3.6 Measuring the Slave Clock Output

For performance evaluation of a G.8261 profile, the recovered clock of the Slave Clock should be measured as follows:

e  Frequency output (MTIE/TDEV measurement) if 1588v2 is being tested for Frequency transfer.
e 1PPS Time of Day output (ToD/1PPS Error measurement) if 1588v2 is being tested for Time/Phase transfer.

3.7 Measuring the Slave Clock Output

1. From the Tools dropdown, for clock output measurements, select Calnex Analysis Tool (E1/T1) or Calnex Analysis Tool
(2M) depending on which measurement you have enabled and selected in 3.5 above.

_________________ e e

-
1Graph  Data | Tools Help

|

E] B iL 1588 Transparent Clack Latency
Calculate differential POV

Split POV files i Tirne-Intel

Join CSV files

PDV Editor 3

File Converter

Script Recorder. ..
View Recorded Script

PTP Field Verifier

Logging

Plot PDF /CDF [Histogram

Calnex Anal

2. The Calnex Analysis Tool (CAT) will be launched to enable analysis of the TIE data metrics. Use the Select Metrics button

to select MTIE and TDEV metrics.

AaT

Select File

Clock Measurements

Select Metrics & TIE/ESMC

View Results & MTIE

Generate Report ™ TDEV

Export

3. Use the View Results button to view the Results. MTIE and TDEV measurements are on separate tabs.

B clkMAFE

@ clkFFO

The masks used below are defined in ITU-T Standard G.8263.

Slave Clock Noise Generation (Clause 6.1):

12



o Ideal input, output mask in G.8263 Table 1 and Figure 2.

Application

i v v ask Status
select File ‘ MTIE | TDE ‘ Mask Status

MTIE E1
Select Metrics Metric Stafi

View Results Min [ns]

Generate Report

Jollf il + T

Export Chart Tools

Markers Editor

Marker 1 | Marker 2 | @&
‘G 813 SEC Opt 1 Wander Gen Var. Temp_
G.813 SEC Opt. 2 Exit from Holdover
G 813 SEC Opt 2 Short-term Phase Transient
'G.813 SEC Opt. 2 Wander Gen Const. Temp.
G.823 E1 PRC Wander Limit
‘G823 E1 SEC Wander Limit
G.823 E1 SSU Wander Limit
G.823 E1 Trafic Wander Limit
G.823 PDH Sync Wander Limit
G.824 PDH RefWander Limit
G824 T1 PRC Wander Limit
G.824 T1 Traflic Wander Limit
G.8261 EEC Opt. 1 Wander Limit
‘G B261 1 PEC-5-F Wander Limit Case 3
G.8262 EEC Opt. 1 Wander Gen Const. Temp.
G 8262 EEC Opt 1 Wander Gen Var. Temp.
G.8262 EEC Opt. 2 Short-term Phase Transient
G.8262 EEC Opt. 2 Wander Gen Const. Temp.
G.8263 PEC-S-F Wander Gen Const. Temp.
G.8263 PEC-5-F Wander Gen Var. Temp.

G 8263 PEC-8-F Wander Gen Var. Tem/ |

MTIE ns)

Slave Clock Noise Tolerance (clause 7.1):
o Input noise defined in clause 8.1.1 of G.8261.1 (FPP of 1% in 150us)
o  Output dependent on use case:

e For atiming a basestation: case 3 from G.8261.1 Clause 7.2.2 (Table 1 and Figure 4)
e  Output for traffic interface (e.g. timing a CES link): case 2 from G.8261.1 Clause 7.2.2

3.8 Measuring the Time/Phase Output of the Slave Clock

1. in the Paragon-X GUI graph area, select CAPTURE - 1pps/GP from the Graph Context dropdown menu:



Graph Con

CAPTURE - 1pps/GP 7|

\h'ﬁ.'wm\ {ﬁ“'"'\\.
LI"“.W ll'njl

The 1PPS accuracy measurement is made at each one-second point on the rising edge of the 1PPS reference signal. The
result tabulated and graphed at each 1-sec interval is the time difference between the rising edge of the measured signal
from the Slave Clock and the rising edge of the reference signal. In normal conditions, this will be a positive value. However,
since it is an absolute measurement, path length differences between measurement signal cabling and reference signal
cabling can be significant. Make these cable lengths similar if possible, and if not then take account of the propagation
error of approximately 5.1 ns per metre of cable length difference.

2. By default, the 1PPS accuracy result is compared against a limit and PASS/FAIL is displayed in a green or red box beside
the graph as shown above. To disable display of the PASS/FAIL indicator, click on the Configure Capture button, select
the 1pps Time Error (Absolute) tab and uncheck the Limit checkbox.

Configure Capture ﬂ

Operating Mode Timing Contral I ToD I 1588 I Sync-E Wander I T1/E1Wander 1pps Time Error{Absolute) |
1pps threshold
Setup Interface
[v Limit I 1500 ps (Range: 0.005 ps to 50 ps)

Cable input calibration
Reference: I 0 ns (Range: -1000 ns to 1000 ns) nj&:n
Measurements

Measurement: IU ns {Range: 0 ns to 1000 ns) njﬁlﬁl

Select Flow

Configure Capture

Start Capture

Add Wander

Packet
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3.9 Enabling Impairments for the Test Cases

1. To enable impairments, click on the Add Impairments/Delay button highlighted below.

|£|Ie Instrument(s) Setup Capture Impair Graph Data Tools Help
G mem FEEEE ccem o Ml EE W N

Start Up
Device Configuration
Master + Slave
) Two Masters

Operating Mode

GPS Emulation

Setup Interface

Configure

Calnex Paragon-X

Test Configuration

DUT Ethernet
cable {ns):

1pps Ref.

cable (ns): D

1pps Meas.
cable (ns): 0 @

Master/Slave/GPS
Emulation

Measurements

Select Flow

Confi Capti
onfigure Capture r—

Start Capture

Add Impairments}
Delay

Measurement

[[1Manual calibration

Calibration e
Start

[] set capture flow filter

Apply changes

Add Wander

Packet
Generation

Statistics]
Results

This will display the Impairments control screen. In G.8261 testing, impairments are applied to the Sync messages in the

forward direction (Master Tx) and to the Delay-Request messages in the reverse direction (Master Rx).

Master Tx Impairments
2. Enable the Master Tx Delay and the Master Rx Delay by ticking the associated checkboxes.

File Instrument(s) Setup Capture Impair Graph Data Tools Help
GH o@s FFEPEA ccem o MeE0 >0 90|

Start Up 22 3
Selected Message Types Intrinsic Delay
Master Tx: Packet size: Small Packets (< 200 bytes)
Operating Mode Master Rx: Delay (us): 6.7

Setup Interface onfigesetinn Delay General Settings

Mode: Type:
) single ingle flow (relative)

Master/Slave/GPS
Emulation

(@) Repeat ) Multi flow
Packet rate (Packets/s):
Measurements >
Physical Corruption Delay Insertion
Select Flow - 60
Packet Corruption Fixed delay (s} 6.0 [ ]

Profile Corruption Variable delay .

Configure Capture

Master Impairments ®
- © Santooth # of Packsts: [ 1000
| Beating,F -]
Master 1 Rx e L N
Start Capture ) Step function
Delay

(@ Latency Max (l4s): | 10006.00

Constant

Add Impairments] Header Overnrite

Delay Physical Corruption
Packet Corruption

Add Wander Profile Corruption

Packet

3. Click on Delay in the Master 1 Tx section to enable its configuration. The selection will be highlighted as: |[IECEN

EOoo@I

Mean (us)
©) Gaussian
Gamma St Dev ()

@ User defined

Timeslot Interval

[ Generate Fized Delzy _,  Ramp
— Periad

G 8261: Systernatic Delay
Imported Profie

No File Imported

4. Select Flow Filter to select the Sync and Delay Request messages for delay impairment.
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Selected Message Type:
Master Tx: Sync

Master Rx: Del-Req

Intrinsic Delay
Packet size: Small Packets (< 200 bytes)

Delay {us): 8.7

Configuration Flow Filter Editor
0 00 00 00 00 01 4000000000 D1 [¥I5ync
Any multicast slave [CIFollow-Up
Master 1 Tx [w|Delay Request
Delay v [ IDelay Response
Header Overwrite [ [ |Announce
) [ Isignaling (from Master)
Physical Corrupton [ | [ Multiple slaves: (@ | signaling (from Slave)
Packet Corruption - I C0:00:00:00:00:01
Profile Corruption v
Master Impairments [ Clear
Flow Filter Status
Master 1 Rx
Delay r Flow Summary: Flow Detail:
Header Ovi ite I Port 1Tx (Master Eth Dest 0115 19000000
- EnTpe o
Physical Corruption
u 00 X PTP Message DEL-REQ
Packet Corruption I X% XXX PTP Version 2
Profile Corruption v et SYNC

NOTE:

o |f the PTP protocol used is a Multicast based protocol (e.g. G.8275.1) the filters can
be set without first running a capture to determine the Slave’s address.

e |f a Unicast based protocol is used (e.g. G.8265.1) then the Paragon-X Master
emulation must be started prior to setting the Flow Filter to enable the Master to
discover the Slave’s address. This has happened successfully when a Slave
address is shown with a green status in the Connected Slave Address window.

Mode: Unicast Forced

[V Rates

Connected Slave
Address

D-Reg
Rate

Rate

Rate

&) 192.158.4. 101
192,168.5.2
192,168.5.3
192.168.5.4
192,168,5.5
192,168,5.6
192,168.5.7
192.168.5.8

128

12

Master emulation is started using the _ button in the Master/Slave Emulation window. After a Slave Clock is

detected the Flow Filter can be set as above.

The Impairment engine is now ready to import delay patterns as described in later sections.

Impairment Patterns

Each test case in G.8261 requires the loading of impairment patterns for both forward and reverse directions as detailed in

16



Appendix 1: ITU-T G.8261 Test Case Profiles for 1588v2 Testing.

Note: impairment patterns for testing to G.8261 and other ITU-T standards may be obtained from the Product Software section
of the Calnex website https://calnexsol.com (registration required).

Master TX Impairments

5. Inthe Master TX - Delay configuration window, select the User defined option and click Import. In the file browser window,

navigate to the location of the desired stored pattern.

<< Results

Selected Message Tpe:

Intrinsic Delay

Master Rx Impairments

Generate
e

Imported Profile

Master Tx: Sync Packet size: Small Packets (< 200 bytes) Change
Master Rx: Del-Req Delay (us): 32.4
Configuration Delay General Settings
Flow Filter Mode: Type: Apply to:
 Single @ Single flow (relative) ¥ Packet sending time
& Repeat € Mult flow € Correction field
Master 1 Tx Packet rate (Packetsfs): [a4 € Both
v
Header Overwrite [
Physical Corruption [ | Delay Insertion
PacketCorrupton | Fixed delay (us): [ 30.0 ]
Rl ey & Variable delay type:
Master Impairments [~
© sautoath # of Packsts: [ 1000
Beating,F -
Master 1 Rx Min (ps): | 30.00
™ Step function
Delay :z " Latency Max (us): | 10030.00
Header Overwrite o
Constant
#Alpha: | 2.00000 Tineslat rterval
RivEE g (W " Gaussian
Packet Corruption [~ € Gamma Beta:[1.00000 | | [ e
Profile Corruption  [#- & User defined

Fixed Delay Ramp
Period

G B2B1: Systematic Delay

| Ci\sratch\ENTProfiles\G8261_Patterns\testcase132\g8261_tc13a_forward_SYNC_16pps_201002091g8261 tc13a_forward YN

6. Repeat the above steps to load the desired Master Rx (reverse direction) delay pattern.

Sefect=d essage Trpe:
Master T Sync

Intrinsic Detay

Packet size: Small Packets (< 200 bytes)

_chenee |

Master Rx: Del-Req Delay (us): 32.4
Configuration Delay General Settings
Flaw Filter Mode: Type: Apply to:
" Single  Single flow (relative) ¥ Packet sending time
@ Repeat © Multi flow " Correction field
[ TR Packet rate (Packets/s): [+ " Both
Delay 2
Header Overwrite [
Physical Corruption [~ | Delay Insertion
PacketCorruption Fixed delay (us): [ 30.0 [ ]
Profile Corruption ~ Variable delay type:
Master Impairments [~
© sautaath # o Pa(k&ts:l 1000
Beating,F -
Master 1 Rx Min {us):| 30.00
" Step function
Header Overwrite [ ~
Constant I—
Alpha: | 2.00000 Timeslot rterval
Eyes @i (i " Gaussian
Packet Corruption [~  Gamma Beta:l 100000 | | | g
Profile Corruption | & User defined P— Ficed Delay _,  Ramp
Period

Imported Profile

(G.8261: Systematic Delay

I C:\Scratch\ENTProfiles\G8261_Patterns\testcase 133\g8261_tc13a_reverse_DREQ_16pps_20100209_V2_NEW.cpd
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3.10Test Execution
Impairments

When ready to test your DUT, start applying the Impairments using the _ button.

Capture
The capture can then be started using the button:

The captured data can be analysed as described in the Non Emulation Mode section (see below).

Test Sequence

Each individual test case requires the following steps:
1. Import the test cases

Start the impairment

Start the capture

Launch the CAT to generate the metrics

Stop the capture

oo r W N

Repeat Steps 1to 5



4. Non Emulation (thru) Mode

4.1 Test Setup

Q Synchronisation Source

.:”“‘ﬁ@

Figure 3. Test Setup for running ITU-T G.8261 performance tests with Paragon-X in non-emulation mode

Physical connections

1.

2.

Connect the PTP Master Clock to Port 1 of the Paragon-X (Figure 1, connectors 2 or 3).

Connect the PTP Slave Clock under test to Port 2 of the Paragon-X (Figure 1, connectors 2 or 3).

NOTE: When using optical ports both SFP modules must be inserted into the Paragon-X to enable selection of the
“Optical” option in the Physical Settings window.

Also note both connections must be at the same rate and same media (Electrical or Optical). If the Master and Slave Clocks
in your test setup are set to run at different rates, add a switch to the test set up.

Connect the external reference, e.g. 10MHz, to the Paragon-X Reference Input (Figure 2, connector 14).

Connect the 1PPS output from the Slave Clock to the Paragon-X 1PPS measurement port (Aux) (Figure 1, connector 1). Use
Calnex’s 1pps/ToD/Frequency Converter accessory if required.

Connect the Frequency, e.g. E1 output from Slave Clock, to the Frequency measurement port at the rear of the Paragon-X
(Figure 2, connector 13).
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4.2 Application Setup

1. Verify that physical connections have been made as described above.

2. From your Windows PC, start the Paragon-X client (GUI) by clicking Start > All Programs > Calnex/Paragon-X (different
Windows operating systems may vary slightly).

3. On the Paragon-X GUI, press Start Up and connect to the Paragon-X (see the Getting Started Guide for more details if
required).

4. Click on the Operating Mode button, select 1688v2 mode, then click the Close button.

Operating Mode ﬂ

Start Up
" CES
Operating Mode ' 1588v2
[ Enable Master/Slave Emulation
Setup Interface " Services
. Sync-E
TR

" Ethernet OAM (302, 1ag, Y. 1731)
£ MPLS-TR OaM (BTN based on ¥ 1731

a-Ach Channel Tvpe: Ox I 8902

Measurements

Select Flow

5. Click on the Measurements button and select E1 (or T1 or 2.048MHz) Wander and 1pps Time Error (Absolute)
measurements. Ensure that the Simultaneous Measurements and Impairments/Delay is selected.

Start Up E

Configuration
¥ Simultaneous Measurements and Impairments/Delay
PDV Capture will be unavailable when enabled.

Operating Mode

Measurements
Setup Interface [ SyncE Wander

[~ Time of day

" Mone

™ T1 Wander

& E1 Wander
Select Flow " 2,048 MHz Wander

Measurements

 Mone
Configure Capture # 1pps Tme Error{absolute) ()
™ 1pps Time Error{Relative) @

Start Capture
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Click on the Setup Interface button. On the Ethernet tab, select Thru Mode then select Line Rate and Interface type.

NOTE: If using SFP/XFP devices, one must be present in both ports to be allow their selection.

Start Up JJ

Operating Mode

Ethernet |ReFerer|ces | Measurement Ports | TaD |

" Tx+RxMode & ThruMode ()

Setup Interface

[~ SyncE Clock Rx -= Tx 'ii'

= Zoupled lﬂl
Port 1 Port 2
Measurements [~ Line Rate ~Line Rate

" 100MbE € 1GBE ¢ 10GhE

C 10o0MbE % 1GBE € L0GHE

Select Flow [ Interface
(" R145 % sFRjSFR+  uFF

r Interface
(CIpJ4s ¥ SER(sFR+ £ WRR

Configure Capture [¥ Auto Negotiate

¥ Auto Meqatiate

r~ GbE Electrical Phy Settings
Start Capture

= Master, % Slave {5 Master ) Slave

% Force Port 1 Part 2
= Preferred ’7 ’7

Add Impairments{
Delay

Close

Add Wander

Select the References tab and set the reference Clock Source according to rear panel reference input used. Set the 1pps
Reference Input selection according to the 1PPS reference input used to connect the common frequency reference or
Master Clock 1PPS reference output to the Paragon-X.

Start Up JJ

‘Ethernet References |MeasurementPorts | ToD I

Operating Mode

r Clock Source
Ext. BNC —— Ext. Bantam Ext. D-type

£ 10MHz 'ﬁ' " T1ternary " 6akb/fs
™ E1/2.048MHz = E1ternary

Setup Interface " Internal

 1pps Reference Input

Start MSE Master
= BNC " GPS D-type  Internal

using 1pps Ref

Measurements

Threshold: I 1.6 V (Range: 0.5V to 2.5V) [~ Master 1

I~ Master 2

Select Flow Termination: " High Impedance &+ 500hm (@)

r~ External Wander Generation
Configure Capture [~ Enable

Wander Clock Source: ITl';-.'ander meas Bantam j

Start Capture

Reference Output (Lower Front Aux Port)
10 MHz o

Add Impairments} 1pps width: I 20000 ps  (Range: 1 to 500,000 ps)

Delay

Close

Add Wander

21



4.3 Selecting Flows and Setting Filters using Flow Wizard

Once setup of operating mode and interfaces is complete, the correct 1588v2 flows to apply the G.8261 profiles to should be
selected. This is achieved by using the Paragon-X Flow Wizard functionality.

The G.8261 Test Case PDV profiles are applied to SYNC messages in the forward direction, and to DELAY_REQ messages in
the reverse direction.

1. Click on Select Flow and the following window will appear:

Start Up

Operating Mode

Setup Interface l;_. Capture Packets

E Elawe yizard

Measurements = = )
. YWireshark

Select Flow

Configure Capture

2. Click the Capture Packets button to start the capture.
3. After a short time (approximately 10 Seconds) click the Stop Capture button.

Start Up

Flow Wizard
. Wireshark

Select Flow

Close

Add Wander

Statistics]
Results
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4. Click on Flow Wizard to display the following screen:

The following flows were detected:
(= 1588 I_ |_ |— |— |Nlﬂows|

Protocols | Eth dst | Eth src | Ethertype | 1588 message

| 1588 clocklD

| 1588 srcport |
1

= cthethetype:ptp  01:1b:19:00:00:00 d0:00:00:00:00:01 Type: PTPv2ov... DEL-REG
01:1b:19:00:00:00 a0:00:00:00:00:01 Type: PTPvZov... SYNC
01:1b:19:00:00:00  a0:00:00:00:00.01 Type: PTPvZov... ANNOUNCE
01:1b:19:00:00:00  a0:00:00.00:00.01 Type: PTPvZov... DEL-RESP

(0000000000000...

Expanded group of flows

Groups
1588 primary [ 1588 pdelay Group of flows
mutticast mutticast

5. Flow Wizard automatically groups flows that have the same value for each of the fields displayed. To show the individual
messages, right click on a pink row and then click “Expand row to show individual message types”.

== Detected Flows AE Lab -0012105

The following flows were detected:

NI

— 188 |~ | = |— | Oter | Alfows]
Protocols | Ethdst [ Eth sre | Ethertype | 1588 message | 1588 clockID | 1588 srcport |
— 01:1b:19:00:00:00  20.00:00:00:00.01 Type: PTPvZov... <Grouped. Rightclick to expand: 0000000000000, 1

= cth etherypeptp  07:1b:15:00.00:00 d0.00:00.00:00.01 Type: PTPv2ov... DEL-REQ

(<0000000000000... 1

Expanded group of flows

— Address key Groups
I Eradoast 1588 primary [N 1588 pdelay Group of flows
multicast multicast

8 Select a flow from the list. Click on a column heading to sort

Set Impair Set Capture

6. Select the flows of interest. Multiple flows can be selected by using either the “Shift” and left mouse button or “Ctrl” and

left mouse button. For G.8261 testing, select the SYNC and DEL_REQ flows.

7. Click to set the Filters and then close the window using the Window control X in the top right corner.

8. Click to close the Select Flow window.

9. The Flow Filter Window in the main Paragon-X GUI (shown below) will now show that filters have been set.
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4.4 Validating the Protocol and Handshaking prior to any Impairments

Ensure that there is correct and regular handshaking and negotiations between the Master and Slave by looking for mis-
ordered, missing, and repeated messages.

Ensure there are no protocol anomalies e.g. protocol errors, invalid fields.
Check for correct packet rates:

e 16/32/64/etc., packets per second for SYNC and DELAY_REQ messages
e Sync, Del_Req, Del_Resp should not exceed 128pps as specified by ITU-T for Telecom unicast applications

Messages between the Master and Slave may be validated as follows:

1.

2.

With no filters set, click on the Start Capture button to start the measurement.

Start Up

Operating Mode

Setup Interface

Measurements

Select Flow

Configure Capture

Start Capture

Add Impairments]
Delay

Add Wander

If desired, stop the measurement (after a pre-defined period for running the test) by clicking on Stop Capture.

Fle Instument Setup Capture Impair Graph Data Tooks Help

Stop Capture

Add Wander

Statistics]
Results
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The header and timing table lets you quickly determine whether there are any mis-ordered, missing or repeated packets.

3. To do this, look at the top of the sequenceld column and check the soft LED icon.
sequenceld Indicates no error
I] sequenceld Indicates there is an error

g5 |

4. To go to the first error use the icon, and the first/next error will appear at the top of the screen. Errors are identified

by messages being highlighted in red.

5. Inthe screenshot above, it can be seen that there is a missing Sync message between sequence Id of 3735 and sequence
id 3737 sent by the Master.

Je

6. To go back to the previous error use the icon, and the previous error will appear at the top of the screen.

7. If no errors are seen during a short run (1 minute), you are ready to start the G.8261 performance tests. If errors are seen,

the most likely cause is a mismatch in settings between the Master and Slave — this is particularly likely in mixed-supplier
situations.
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4.5 Importing and Replaying a G.8261 Test Case

For G.8261 testing, it is required to load two profiles; one for the forward direction (for SYNC messages from the Master to the

Slave), and one for the reverse direction (for DEL_REQUEST messages from Slave to Master).

NOTE: For testing 1588v2 in accordance with G.8261, bidirectional test cases 12-17 are used. Calnex has a library
of these profiles at each relevant packet rate (from 2 packets per second to 128packets per second). These may
be obtained from the Product Software section of the Calnex website https://calnexsol.com registration required).

To load the G.8261 profiles:

1. Click on Add Impairments/Delay and the following window will appear:

T L P W 1mpairments/ oelay =[5

Instrument Intrinsic Delay
™ Enable ’7 Select | Intrinsic Delay for Jumbo Packets (< 12000 bytes) is 100.0 ps . ‘

1588 Messages - Selected by Fl izard
Port1:Sync
Port2:Del-Req
Corruptions I Overwrite Delay |
% — Mode Type Apply to
etup Interface  singl
’7(3' Rlss:at ISingIe Flow (Relative) 'l IPacket Sending Time j
Port 1-»Port2 |  port2->Port1]

~Fixed Delay Insertion {Jatency)
| 100.0 ps i

r~ Variable Delay Insertion

[~ Enable 1 Satonth IBeaﬁng.F hid l

€ Step Funckion, € Jitker,

Configure Capture ) Latency ) Gaussian
{7 Canstant: £ Gamma
# of Packets 1000
Start Capture _— )
Min [ 100.00 us Imparted Profile
A Max | 10100.00 (Fixed delay will offset imported profile)

Add Impairments} =
Delay Mean | 5100.00 ps
StdDev | 1000.00 s

EULRYETIE Generate |
1% User Defined Imnpatt: | |:Auho Leve'}

I™ | rop Packets Using Gaptured Sequence I~ Enable

Belagis s Port Packet Rate (Packet/s
[ enabled rate match (7] ’7Port 1 I 1 Port2 |1 Change |

Statistics{
Results Stark Impaitments | Stop Impairments | Close |

letahie: Tdla

2. Tick the Enable 1 e st bOX.

NOTE: Immediately the Enable box is checked, the Instrument Intrinsic delay is applied to ALL traffic. This might
cause the Slave to lose lock and further settling time might be required before the application of PDV.

3. Inthe Add Impairments/Delay window, tick the box to Enable “Variable Delay Insertion” in both directions (Port 1> Port

2 and Port 2 > Port 1).
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4. When “Variable Delay Insertion” is enabled in both directions, the “Delay” and each of the port direction tabs display
green tick boxes:

Add Impairments/ Delay = IEIIﬂ

Instrument Intrinsic Delay
’7 Select | Intrinsic Delay for Jumbo Packets (< 12000 bytes) is 100.0 ps .

¥ Enable
" 1588 Messages - Selected by FlowWizard

Portl:Sync
Port2:Del-Req

Conupﬁonsl Owverwrite Delay |

pode Type Apply to
Single - - :
’7(: Repeat ’7|5IHQ|E Flow (Relative) j ’]PEd{Et Sending Time j

Port 1->Port 2 Port 2 -» Port 1 |

NOTE: Imported profiles are designed to be replayed against Sync and Delay Request messages only. If
Flow Wizard was used earlier to select multiple messages for analysis, Flow Wizard must be used again so
that only Sync and Delay Request messages are selected.

5. (.8261 test case profiles may now be imported, one for each direction. The G.8261 profiles from the Calnex website are
labeled to identify their direction and packet rateAn example pair is:

e g8261_tc12_forward_SYNC_32pps
e g8261_tc12_reverse_DREQ_32pps

Where:
“g8261_tc12” identifies the specific ITU-T G.8261 test to be performed, in this instance testcase 12,
“forward_SYNC” identifies the direction and 1588v2 messages within the profile, and

“32pps” identifies the packet rate.

6. Import the forward profile for the Port 1 > Port 2 direction by clicking on the Import button within the Add
Impairments/Delay window. (Note: if this selection is greyed out, ensure that the “Variable Delay Insertion” Enable box is
checked.)

Variable Delay Insertion

¥ Enable " Sawtooth |Beaﬁnng *I

" Step Function € Jitter
" Latency " Gaussian
" Constant " Gamma

#ofPadets [000
Min 100000 ps Imported Profile
Max [10100.00 s (Fixed delay wil offset imparted prafile)
Mean IW s
Std Dev W us

Fenerake |

Auto Level
[T Drop Pack® Equence | 7| Enable
e Port Packet Rate (Packet/s
[ enabled rate match (7] |Vport 1 I 1 Port2 |1 Change

art Impairments | Skop Impairrents |
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10.

Replay
Progress

1.

On clicking the Import button, browse your PC for the location of the forward profile you want to load.
Click Open. The profile is now enabled for the Port 1> Port 2 direction.
Click on the Port 2 > Port 1 tab and repeat steps 6 to 8.

To start the overwrite, click on the Start Impairments button and the following screen is shown:

Lencth  dom

Port1 Replay

Port2 Replay

The replayed profile for each direction is displayed. Each graph has a red vertical bar above it which shows the progress
of the replay of the delay profile.

For G.8261 testing, there is a required amount of time that each test must run before checking the results. Review Appendix
2 for further information.

The replay can be stopped by clicking on the Stop Impairments button.

NOTE: The G.8261 Test case must be started before the measurements on the Slave Clock. There is a
stabilisation period allowed in G.8261 (900 seconds or 15 minutes). The Calnex G.8261 Test Case profiles
have a stabilisation period of 15 minutes at the beginning, so start the profiles as shown above but only
start the performance measurement steps after 15 minutes.

15 minutes is a suggested stabilisation period, but some equipment might take longer than this. Individual
equipment designers should be able to advise the appropriate settling time. If a greater period is required,
profiles can be modified by using the PDV Editor tool as described in Appendix 1.

Performance measurement should generally start after the stabilisation period, but exact timings depend
on the profile being used. Details are provided for each profile in Appendix 2.
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4.6 Measuring the Slave Clock Output

For performance evaluation of a G.8261 profile, the recovered clock of the Slave should be measured as follows:

e Frequency output (MTIE/TDEV measurement) if 1588v2 is being tested for Frequency transfer.

¢ 1PPS Time of Day output (ToD/1PPS Error measurement) if 1588v2 is being tested for Time/Phase transfer.

4.7 Configuring Paragon-X to Measure the Slave Clock Output

Verify that 1588v2 mode is selected and E1/T1 /2.048MHz Wander and 1pps Time Error (Absolute) measurements are

selected:

Start Up

Operating Mode

Setup Interface

Measurements

Select Flow

Operating Mode ﬂ

 CcEs
¥ 1588v2
[ Enable Master Slave Emulation
" Services
" SyncE
TR
" Ethernet OAM (802.1ag, ¥.1731)
) MPLS-TP O&M (PTH based an ¥, 1731

G-fch Channel Tyvpe: O I 8902

Operating Mode

Setup Interface

Measurements

Select Flow

Configure Capture

Start Capture

Configuration

Measurements

W Simultaneous Measurements and Impairments/Delay
POV Capture will be unavailable when enabled.

[ SyncE Wander

[~ Time of day

" None

" T1Wander

{* E1Wander

" 2,048 MHz Wander

" Mone
¥ 1pps Time Error(Absolute) @
" 1ipps Time Error(Relative) l@
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4.8 Measuring the Frequency Output (E1/T1 Wander) of the Slave Clock

1. Click on the Start Capture button.

2. From the graph, select the measurement data from the Graph Context pull down menu.

CAPTURE - 1588v2
CAPTLRE - 1pps/GP

Grap t
CAPTURE -E1/T1

B P
1Graph Data | Tools Help
|

E] R iL 1588 Transparent Clodk Latency
Calculate differential PDV

Split PDV files

Join CSV files

PDV Editor »

File Converter

Script Recorder...
View Recorded Script

PTP Field Verifier

1DE ACTIVE

Logging

Plot PDF/CDF Histogram
Calnex Analysis (E1

ol ||

Snapshot currently selected data and send to Calnex Analysis
Tool




5. The Calnex Analysis Tool (CAT) will be launched to provide metric analysis of the TIE data. Use the Select Metrics button
to enable the MTIE and TDEV metrics.

Select File Clock Measurements

Select Metrics M TIE/ESMC

View Results = MTIE

Generate Report & TDEV

Export B clkMAFE

B clkFFO

6. Click on the View Results button to view the results. Note that MTIE and TDEV are on separate tabs.

Note: Masks to be used are defined in ITU-T Standard G.8263;

e  Slave Clock Noise Generation (clause G.8363 Clause 6.1):
o ideal input, output mask in Tablel1/Figure 2 of G.8263
Application

/ ) ask Status
Select File | MTIE | TD Mask Status

MTIE E1

Select Metrics Metric Statistics

View Results Min [ns]

Generate Report

Export Chart Tools
Markers Editor

Marker 1 | Marker 2 |
G.813 SEC Opt. 1 Wander Gen Var. Temp.
i i G813 5EC Opt 2 Exit from Holdover

EC-S-F Wander Gen Var. Temp. G.813 SEC Opt. 2 Short-term Phase Transient
G813 SEC Opt. 2 Wander Gen Const. Temp.
G.823 E1 PRC Wander Limit
G.823 E1 SEC Wander Limit
G.823 E1 55U Wander Limit
G.823 E1 Trafic Wander Limit
G.823 PDH Sync Wander Limit
G.824 PDH RefWander Limit
G.824 T1 PRC Wander Limit
G.B24 T1 Trafic Wander Limit
G.8261 EEC Opt 1 Wander Limit
G.8261.1 PEC-5-F Wander Limit Case 3
G.8262 EEC Opt. 1 Wander Gen Const. Temp.
G.8262 EEC Opt. 1 Wander Gen Var. Temp.
(G.8262 EEC Opt 2 Short-term Phase Transient
G.B262 EEC Opt 2 Wander Gen Const. Temp.
G.B263 PEC-S-F Wander Gen Const. Temp.
G.8263 PEC-5-F Wander Gen Var. Temp.

G.B263 PEC-5-F Wander Gen Var. Tem' ¥ |

e Slave Clock Noise Tolerance (clause 7.1):
o Input noise defined in clause 8.1.1 of G.8261.1 (FPP of 1% in 150us)
o  Output depends on use case:
e Foratiming a base station: case 3 from G.8261.1/Clause 7.2.2 (Table 1/Figure 4)
e  Output for traffic interface (e.g. timing a CES link): case 2 from G.8261.1/Clause 7.2.2
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4.9 Measuring the Time/Phase Output of the Slave Clock

1. Select Graph Context and choose CAPTURE - 1pps/GP.

Graph Contest:
CAPTURE - 1pps/GP

‘mﬁ.,l\'*m"l‘ ﬂ“l.hf\,
LI"“.Mu"hnjl

| n ’I‘ lﬂ r rll,q
Wﬁl,,ff‘wﬁﬂ' "‘I'1""ﬂ"'|"““lﬂ,|'mh 1}.J"I1r|fl*.uﬁ |'-J"J”|.f'. » 'JJI| “ﬂx
h.l\l’l i

A
|

NOTE: The 1PPS accuracy measurement is made at each 1-second point on the rising edge of the 1PPS reference signal.
The result tabulated and graphed at each 1-second interval is the time difference between the rising edge of the measured
signal (from the Slave Clock) and the rising edge of the reference signal. In normal conditions, this will be a positive value.
However, since it is an absolute measurement, path length differences between measurement signal cabling and
reference signal cabling can be significant. Make these cable lengths similar if possible, and if not, allow for the propagation

error of approximately 5.1 ns per metre of cable length difference.

2. The 1PPS accuracy result is compared against a limit and PASS/FAIL is displayed in a green or red box on the graph as

shown above (circled). Limit checking is enabled and the limit set under Configure Capture as shown below.

X

Configure Capture

Operating Mode “Timing Control | ToD | 1588 | SyncE Wander | T1/E1Wander  1pps Time Error(Absoiute) |
1pps threshold
Setup Interface
¥ Limit I 1500 s (Range: 0.005ps to 50 ps)

Cable input calibration

Reference: IU ns (Range: -1000 ns to 1000 ns) iﬁ]

Measurement: IU ns {Range: 0 ns to 1000 ns) ujjij.

Measurements

Select Flow

Configure Capture

Start Capture

Add Wander

Packet
Generation

-U. UL | ——— ——————————

Close
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4.10 Analysis of Failing Test Results

If the Slave Clock output fails the MTIE/TDEV or 1PPS measurements, the next step is to identify the cause of the failure. This
can be challenging for G.8261 tests as there may be a number of contributing factors. Some possible factors are listed below.
This is not an exhaustive list, and is provided for guidance only:

¢ Noise Floor Delay Raised during Peak Traffic — During periods of high traffic, the noise floor may rise, which can increase
the likelihood of test failure.

(Adjusting Delay Floor — It may be possible to adjust the Delay Floor using the Paragon’s “PDV Editor” function. Appendix 1
describes the PDV Editor in greater detail.)

e Check Quality of Clock Oscillator — The clock oscillator (crystal) should be of at least “carrier-grade” quality

e Check the Line Rate — confirm the packet rate configured for the test matches the packet rate of the applied delay profiles:
failure to do so will result in a test failure.

e Algorithm working as expected? — Check your test parameters and verify correct operation.
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Appendix 1: ITU-T G.8261 Test Case Profiles for 1588v2 Testing

Network Traffic Models Used for G.8261

Traffic over mobile networks can never be assumed to operate in a pre-defined mode. According to one mobile network
authority, access traffic is composed of conversational (voice), streaming (audio/video), interactive (e.g., http) and background
(sms, email). It is known that in wireless networks, 80% to 90% of the traffic is conversational, with the average call lasting from
1 minute to 2 minutes.

Two traffic models have been defined in G.8261, identified as Network Traffic Model 1and Network Traffic Model 2. A synopsis
of each model is provided below:

Network Traffic Model 1

Network Traffic Model 1 assumes 80% of the load should be based on packets of fixed small size constant bit rate, and 20%
based on packets with a mix of medium and maximum size. The packet size profile is:

o 80% of the load must be minimum size packets (64 octets)
e 15% of the load must be maximum size packets (1518 octets)
e 5% of the load must be medium size packets (576 octets)

Maximum size packets will occur in bursts lasting between 0.1s and 3s.

Network Traffic Model 2

Bigger packets compared with the Network Traffic Model 1 compose the Network that handles more data traffic. To be able
to model this traffic, 60% of the load should be based on packets of maximum size, and 40% on packets with a mix of minimum
and medium size. The packet size profile is:

e 60% of the load must be maximum size packets (1518 octets)
e 30% of the load must be minimum size packets (64 octets)
e 10% of the load must be medium size packets (576 octets)

Maximum size packets will occur in bursts lasting between 0.1s and 3s.

NOTE: The G.8261 Test Case must be started before the measurements on the Slave Clock. There is a
stabilisation period allowed in G.8261 (900 seconds or 15 minutes). The Calnex G.8261 Test Case profiles
have a stabilisation period of 15 minutes at the beginning, so start the profiles as shown above but only start
the performance measurement steps after 15 minutes.

15 minutes is a suggested stabilisation period, but some equipment might take longer than this. Individual
equipment designers should be able to advise the appropriate settling time. If a greater period is required,
profiles can be modified by using the PDV Editor tool as described in Appendix 1.

Performance measurement should generally start after the stabilisation period, but exact timings depend on
the profile beinqg used. Details are provided for each profile below.
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G.8261 Test Case 12
Test case 12 models the “Static” Packet load. Test Case 12 must use the following network conditions:

e Network disturbance load with 80% for the forward direction (Server to Client) and 20% in the reverse direction (Client to
Server) for 1 hour.

The test measurements should start after the clock recovery is in a stable condition. Guidance on stabilisation period is
provided in Appendix Il of G.8261 and should be a minimum of 900s. The disturbance background traffic to load the network
must use Network Traffic Model 2 as defined below:

PDV Graphs Test Case 12
The two diagrams below show Sync PDV and Slave Wander PDV respectively:

Port2 Replay

Test Case 12 Performance Evaluation: The first 15 minutes of the profile is a stabilisation period. After this
time, start capturing E1/T1 and 1PPS accuracy. These measurements should remain within the specified
limits for the duration of the replay, which is 1 hour after initial stabilisation.
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G.8261 Test Case 13a/b

Test Case 13 models sudden large, and persistent changes in the network load. It demonstrates stability on sudden large
changes in network conditions, and wander performance in the presence of low frequency PDV. Test Case 13 must use the
following network conditions:

e The packets to load the network must use Network Traffic Model 1 (Test Case 13a) as defined in ITU-T G.8261.

e Allow a stabilisation period according to Appendix Il for the clock recovery process to stabilise before doing the
measurements

e |In the forward direction: Start with network disturbance load at 80% for 1 hour, drop to 20% for an hour, increase back to
80% for an hour, drop back to 20% for an hour, increase back to 80% for an hour, drop back to 20% for an hour.
Simultaneously, in the reverse direction: Start with network disturbance load at 50% for 1.5 hours, drop to 10% for an hour,
increase back to 50% for an hour, drop back to 10% for an hour, increase back to 50% for an hour, drop back to 10% for 0.5
hour (see Figure VI.11/G.8261). Repeat the test using the Network Traffic Model 2 (Test Case 13b) as defined above to load
the network

PDV Graphs Test Case 13a (Network Traffic Model #1)

Port2 Replay

Port1 Replay

Port2 Replay

Test Case 13 Performance Evaluation: The first 15 minutes of the profile is a stabilisation period.
After this time, start capturing E1/T1 and 1PPS accuracy. These measurements should remain
within the specified limits for the duration of the replay, which is 6 hours after initial stabilisation.
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G.8261 Test Case 14a/b

Test case 14 models the slow change in network load over an extremely long timescale (24 hours). It demonstrates stability
with very slow changes in network conditions, and wander performance in the presence of extremely low frequency PDV.
Test Case 14 must use the following network conditions:

e The packets to load the network must use Network Traffic Model 1 (test case 14a) as defined above.

e Allow a stabilisation period according to Appendix Il for the clock recovery process to stabilise before doing the
measurements.

e In the forward direction: Vary network disturbance load smoothly from 20% to 80% and back over a 24-hour period.
Simultaneously, in the reverse direction: Vary network disturbance load smoothly from 10% to 55% and back over a 24-hour
period (see PDV graphs below).

PDV Graphs Test Case 14a (Network Traffic Model #1)

Port2 Replay

Test Case 14 Performance Evaluation: The first 15 minutes of the profile is a stabilisation period.
After this time, start capturing E1/T1 and 1PPS accuracy. These measurements should remain
within the specified limits for the duration of the replay, which is 23 hours 45 minutes after initial
stabilisation.
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G.8261 Test Case 15a/b

Test case 15 is a test that models temporary network outages and restoration for varying amounts of time within the network.
It demonstrates ability to survive network outages and recover on restoration.

Test Case 15 must use the following network conditions:
e The packets to load the network must use Network Traffic Model 1 as defined in VI.2.1.

e Start with 40% of network disturbance load in the forward direction and 30% load in the reverse direction. After a stabilisation
period according to Appendix Il, remove network connection for 10s, then restore. Allow a stabilisation period according to
Appendix Il for the clock recovery process to stabilise. Repeat with network interruptions of 100s.

e Repeat the test using the Network Traffic Model 2 as defined in VI.2.2 to load the network.

PDV Graphs Test Case 15a (Network Traffic Model #1)

Port1 Replay

Port2 Replay

Port1 Replay

NOTE: The outage periods are represented by the orange regions of the graph. This indicates
that during these periods, packets will be dropped to simulate traffic outage. In order for the
packets to be dropped, the G.1050 Corruption function must be enabled.
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Profile (G.1050) enabled on both ports:

Add Impairments/ Delay

- —

Test Case 15 Performance Evaluation: The first 15 minutes of the profile is a stabilisation period,
followed by a 10 second outage, a 15 minute recovery period, a further 100second outage and
another 15 minute recovery period. After this final recovery period, start capturing EV/T1 and 1PPS

accuracy. Continue capture for 1 hour, during which measurements should remain within the
specified limits.
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G.8261 Test Case 16a/b

Test case 16 models temporary network congestion and restoration for varying amounts of time, it demonstrates ability to
survive temporary congestion in the packet network.

Test Case 16 must use the following network conditions:
e The packets to load the network must use Network Traffic Model 1 as defined in VI.2.1.

e Start with 40% of network disturbance load in the forward direction and 30% load in the reverse direction. After a stabilisation
period according to Appendix Il, increase network disturbance load to 100% in both directions, inducing severe delays and
packet loss for 10s, then restore. Allow a stabilisation period according to Appendix Il for the clock recovery process to
stabilise. Repeat with a congestion period of 100s.

e Repeat the test using the Network Traffic Model 2 as defined in VI.2.2 to load the network.

PDV Graphs Test Case 16a (Network Traffic Model #1)

Port2 Replay

Port1 Replay

=rall bir

Port2 Replay

Test Case 16 Performance Evaluation: The first 15 minutes of the profile is a stabilisation period,
followed by a 10 second period of congestion, a 15 minute recovery period, a further 100 second
period of congestion and another 15 minute recovery period. After this final recovery period,
start capturing E1/T1 and 1PPS accuracy. Continue capture for 1 hour, during which
measurements should remain within the specified limits.
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G.8261 Test Case 17a/b

Test case 17 models routing changes caused by failures in the network. The test case must use the following network
conditions:

e Change the number of switches between the DUTs, causing a step change in packet network delay.
e The packets to load the network must use Network Traffic Model 1 as defined in VI.2.1.

e Start with 40% of network disturbance load in the forward direction and 30% load in the reverse direction. After a
stabilisation period according to Appendix I, reroute the traffic (in both directions) to bypass one switch in the traffic path.
This shall be done by updating the test set up in figure VI.10/G.8261 adding a cable from switch in position “n” to switch in
position “n+2” and either using a fibre spool or adding an impairment box able to simulate different cable lengths (10 ps and
200 ps can be simulated as typical examples). The configuration shall be done so that the traffic flow under test is routed
directly from switch in position “n” via the new link to switch in position “n+2”. After disconnecting the cable from switch “n”
to switch “n+2” (so that traffic under test will then be routed from switch in position “n” to switch in position “n+1”), allow a
stabilisation period according to Appendix Il for the clock recovery process to stabilise, and then reconnect the link that was
disconnected in order to restore the traffic on the original path.

e Start with 40% of network disturbance load in the forward direction and 30% load in the reverse direction. After a stabilisation
period according to Appendix Il, reroute the traffic to bypass three switches in the traffic path.

PDV Graphs Test Case 17a (10uS Traffic Model #1)

Port1 Replay

Port2 Replay

-0.000004121

Port1 Replay

Port2 Replay
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PDV Graphs Test Case 17a (200uS Traffic Model #1)

NOTE: At each step or discontinuity, there is short period when packets are lost. This is
represented by the narrow orange regions of the graph. In order for these packets to be
dropped, the G.1050 Corruption function must be enabled as for Test Case 15.

Test Case 17 Performance Evaluation: The first 15 minutes of the profile is a stabilisation period,
followed by a network discontinuity, a 15 minute recovery period, a further network discontinuity
and another 15 minute recovery period. After this final recovery period, start capturing E1/T1 and
1PPS accuracy. Continue capture for 1 hour, during which measurements should remain within
the specified limits.
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Appendix 2: Capturing and Analysing 1588v2 Messages from a Live Network

Paragon-X can be used to capture 1588v2 packet delay data and Slave Clock output wander/1PPS accuracy from a live network
as a troubleshooting tool for problems existing in the network. The network capture can be saved and then analyzed in the
lab for troubleshooting purposes. The Paragon-X further allows you to edit the PDV capture, increasing or decreasing the
PDV, then replaying that file to narrow in on the fault and determine the performance margin.

Placement of Paragon within the Network for Live Capture

For live network capture the Paragon unit should always be placed next to the Slave Clock as shown below:

| |

Calculating PDV in a 1588v2 Network

Transmission of IEEE 1588v2 packets may require each node to process a time stamp, which incurs delay. As a result, the
number of hops in a network can cause accumulated delay and have a direct impact on the accuracy of time synchronization
signals. As a store-and-forwarding mechanism is used in the network, Packet Delay Variation (PDV) may have a significant

impact on accuracy. Signal degradation, temperature, and frequency synchronization are other factors that may impact
accuracy.

Connect Paragon-X and proceed up to the end of section “4.3 Select flows and set filters using Flow Wizard” above.

Configure Capture: IEEE 1588
If required, the 1588 Settings window allows additional settings for 1588v2 capture.

1. Click on the Configure Capture button.

SETTINGS Sarnnl... i i
oo F

Operating Mode 'Timing Control | ToD 1588 | SyncE Wander I T1/E1 Wander I 1pps Time Error(Absolute) |

Start Up

Clock Mode

Setup Interface
™ 1 step dock (Sync) " 2 step dock (Sync+Fallow Up)

Delay Timing Measurements

™ Indude CorrectionField in Delay Calculation

Measurements

Structure
10
Select Flow 1538 Packet Rate Packets/s
Absolute Time Locking

Configure Captur I™ | Statt capture at Top of Second of 1pps Reference Input (if present) @

DUT Ethernet cable calbration (ms): I':' (Range: 0 ko 1000 ns) @
Start Capture |
1pps Reference cable calibration (ns): ID (Range: -1000 to 1000 ns) @
ESMC Monitoring
Add Wander I Port1->Port2 | Port2-»Part1

Packet

2. Select either 1step (Sync only) or 2 step (Sync + Follow_Up) clock mode.

3. Tick the box if the CorrectionField value contained in the Sync message is to be included in the calculation of the captured
PDV. This is typically used when testing a 1588v2 Transparent Clock.
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4. Enter the 1588 Packet rate — this is used if captured data is exported to Symmetricom TimeMonitor.

5. ESMC Rx Monitoring — the instrument will capture ESMC messages in one direction when in 1588 mode.

Capturing IEEE1588 Header and Timing Information

Once a live capture is started, 1588v2 packets will be displayed in the main body of the Paragon GUI, and a graph will
automatically start that defaults to the inter-packet gap for all messages.

1. Click on the Start Capture button. The Timing Header and directional information for each message will be displayed in
the table and the graph will show the inter-packet arrival time. The table continues to update in real-time with the captured
bi-directional 1588v2 messages.

Start Up

Operating Mode

Setup Interface

Measurements

Select Flow

Configure Capture

FLOW FILTER
Start Ca ture °

Add Wander

Packet
Generation

2. Click on the Stop Capture button to stop the capture.

3. By default the Paragon shows all the fields in a 1588 message header. Itis possible to reduce the number of fields displayed
to those of interest by selecting the 1588 Column sorter that can be found under Data in the top menu.

4. Export the capture, using File Export, as a .cpd or .csv file.
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Analyzing the IEEE 1588v2 Capture

Once you have completed a capture of your live network data, the data can be imported, edited and analysed either in the

field or in a laboratory environment.

Evaluation of 1588v2 Capture

Paragon-X will measure the PDV captured throughout the network, providing the data required to prove performance in the
mobile backhaul network (mobile network requirements are listed in the chart below). Live network capture on Paragon-X can
also be saved and brought back to the lab for further analysis and troubleshooting.

Base Station Frequenc Time
Application d Y
Goal: <3ps
+
CDMA2000 50 ppb Must Meet: <10ps
GSM 50 ppb N/A
WCDMA 50 ppb i
: 3us inter-cell phase
TD-SCDMA 50 ppb difference
LTE (FDD) 50 ppb i
**3us inter-cell phase
LTE (TDD) 50 ppb " differencep
**5us inter-cell phase
LTE MBMS 50 ppb difference
FemtoCell 250 ppb b
2 ppm absolute, i
WIMAX (TDD) [ ~50 ppb between WL
h 1-15ps
base stations
Backhaul NAW 16 ppb sl

By identifying the cause of the failure, operators and clock manufacturers can re-engineer their network or equipment to
prevent similar failures in the future. There are two strategies that operators and network equipment manufacturers can use
to re-engineer their equipment to better cope with these network events:

1. Re-calibrate or re-engineer their clock equipment to better cope with the PDV profiles that causes a clock recovery failure.
2. Re-engineer the network such that these catastrophic PDV patterns do not appear again in the network. Operators can do
the following depending on the cause of the PDV pattern:

e Re-route the PTP traffic to a less congested path (forward and reverse direction).

e Reduce the number of nodes between the Master and Slave by rerouting the PTP traffic (forward and reverse direction).

e Re-route traffic to ensure forward and reverse paths are more symmetrical if asymmetry is causing the problem.

e Implement transparent or boundary clocks to reduce PDV seen by the slave.
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Using PDV Graphs in Paragon-X

The Paragon offers extensive graphing facilities to analyze the 1588 Master — Slave timing.

1.

To access the graphs click on Select Graph. This brings up a menu that allows:

e Graph Display Mode — access to the different graphs for analysis

PDV Graphs — 1588

e Sync PDV

e Slave Wander

e Pdelay_Req PDV
e Pdelay_Resp PDV
e Follow_Up PDV

e Delay_Resp RTD
e Delay_Req PDV

e Round Trip PDV

Inter-packet Arrival Time vs Time

Displays the Inter-packet arrival time for a
specific message against time.

e Sync

e Delay_Req
e Pdelay_Req
e Pdelay_Resp
e Follow_Up

e Delay_Resp

Inter-packet Arrival Time vs Packet #

Displays the Inter-packet arrival time
against packet number.

e Auto-graph refresh — the graph refreshes approximately every 10 seconds

e Graph Format — Chose between line or dot graph format

e Show 2" Graph — A second graph is displayed of the same data

e |ock Graphs — If second graph is selected above locks x axis zoom position.

e Open in New Window — Graph is opened in a new window

A description of each graph with examples is provided on the following pages. Note that all PDV graphs show the variation

between values and not absolute values.
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Sync PDV (1 step)

The Paragon uses the arrival time of the Sync message at the Paragon and the timestamp from the Sync message to calculate
Sync PDV.

time

v Propagation Delay s
Message Exchange

Sync PDV (2 step)

The Paragon uses the arrival time of the Sync message at the Paragon and the timestamp from the Follow-Up message to
calculate Sync PDV (see PacketSync Settings Specific to 1588v2 to select 1-step or 2-step). The correction field from a
transparent clock can be used in the calculation.

"

W iy }1{\ W * i i f M 0 W | }f. I W

4._ S —

time

Propagation Delay -
Message Exchange Sync PDV — Example of a Live Capture
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Follow_Up PDV
The Paragon graphs the variation in arrival time of the Follow_Up message with respect to the Sync message as shown below:

CAPTURE - 1 S8Bvz2

I arkers

time

, Propagation Delay

Message Exchange

Follow_Up PDV - Example of a Live Capture

Slave Wander

The Paragon extracts the embedded timestamp within the Delay_Req message and compares it to the Master Reference, the
variation is then graphed to provide the Slave Wander output as shown below:

CAPTURE - 1588v2 B

,h

1
| L11 Il

|
|
l
| Ll

ﬂl / m H

i i il

! M

\IW

Propagation Delay
Message Exchange

Slave Wander — Example of a Live Capture
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Delay_Resp Round Trip Delay (RTD)

The Paragon calculates and graphs the time difference between the arrival time of the Delay_Req message and the
corresponding Delay_Resp message as shown below:

CAPTURE - 15882

time Propagation Delay

Message Exchange

Delay_Resp Round Trip Delay (RTD) — Example of a Live Capture

Delay_Req PDV

The Paragon graphs the variation between the launch time (arrival time at the Paragon) of the Delay_Req message and the
embedded timestamp, t4, in the Delay_Resp message as shown below:

CAPTURE - 15882

time

Propagation Delay
Message Exchange

Delay_Req PDV — Example of a Live Capture
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Round Trip Delay
The Paragon graphs the variation in (12 — t1) + (t4 — t3) Round Trip Delay i.e. the calculation performed by the Slave as shown
below:

CAPTURE - 1688+2

Propagation Delay
Message Exchange

Round Trip Delay — Example of a Live Capture
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Description of Inter-packet Arrival Time vs Time Graphs

For each of the 1588 messages it is possible to graph the Inter-packet arrival time versus time. This will allow you to have
enhanced visibility of the 1588 network by determining if the messages are arriving at regular intervals and/or if they are being

delayed by the network, Master Clock or Slave Clock.

.,f

ul i \"}'\

i
i

Paragon Packet Distribution Charts

\.‘ "‘“ I |;”1 “ "'1|| || |

i

™

s 4\

i }

Graph Context:
CAPTURE - 15882

}\l" I \ ”w

The packet distribution function allows the analysis of a delay data set from a capture to be analysed and presented graphically
as a Probability Density Function. The data to be analysed must be present in the GUI of the instrument either from a capture
or from loading in a previous capture of profile. The tool is accessed in the following manner:

1. Once a capture has been loaded select the Graph menu item from the Paragon main menu.

2. From the Tools dropdown, select Calnex Analysis Tool (1588v2) > PDV.

Tools Help

4 1588 Transparent Clock Latency
= Calculate differential POY

split PDV files
Join CSV files 0 5
DV Editor (30 s

o
[#5]

File Converter

(1,]
L

Script Recorder...
View Recorded Script

[#5]

L%y

(53]
L

FTP Field Verifier

Logging 3

Plot PDFICDF,ﬂ-Ilstogram ________

Time Error Measurement
""" [ PDV

Transparent CIu:uck. Aocuracy Measurement:

4904
4905
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3. This launches the CAT. Select the Sync PDD metric.

Select File

Select Metrics

Packet Measurements

View Results

2 POV 100% ~

Generate Report [ PDD/CDF ~ 7

v/ Syne PDD 100%
[ ]

@ &« Delay Req PDD

B & Delay Req CDF

4. Click on the View Results button to display the metric. This will provide a Pass/Fail indication based on the limits set.

PDD {CDF Mask Status
Sync PDD
Sync PDD
o Metric Statistics
Mean [us]
Min [ps]
[us]
Min [us]

o006 -2N

Chart Tools
Markers Editor
Marker 1 | Marker 2 | &
Chart & Zoom mode
- +
& Fit @ Overlay © Stacked
Visible Elements

¥ Errors [ Labels Markers

Number of Packets

V]
Autohide Threshold % Statistics

Save As Image

Parameters

‘Range (Between min and max)
Min:

Max:
Normalize Data
Delay < Ons PDV of 0% packels

Pass criteria
20

Deisy [ps]

% In Range

5. Arecord of the result can be obtained using the Generate Report button. This will produce a PDF report file which will
contain the PDD analysis data.

—
Page 2 of 4 Calnex

PDD Analysis

[Direction Forward ]

« Syne so0

%

Mo of Paches

3

=
Getseal

Mean [us] 47.367

Min [ps] 0

Max [us] 98.935

Max-Min [s] 98,935
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Appendix 3: Using the PDV Editor

This feature allows captured timing profiles to be manipulated in a number of ways. It is intended to aid experimentation to
establish limits of operation and margin testing, and to allow network events to be combined to produce a composite profile
which will speed up testing. The tool operates on all profiles captured by Paragon when in IEEE 1588 or Services modes of
operation, and the supplied G.8261 test case profiles.

The G8261 Test case 13b profile is used as an example in the rest of this Appendix.
1. Disconnect the Paragon-X GUI from the instrument.
2. Click on File and Import from the menu bar to import a .cpd file to edit.

3. From the Tools dropdown, select PDV Editor > On.

Tools Help

1588 Transparent Clack Latency
= Calculate differential PDV
Split POV files
Join CSV files
PDV Editor

File Converter w Off

Script Recorder. ..
View Recorded Script

PTP Field Verifier

Logging »

Plot PDF/CDFHistogram
Calnex Analysis Tool (1588v2)
=

When the profile editing mode is enabled, the SETTINGS status section on the GUI will show:

FOWEDITO

4. Edit the profile by placing the cursor on the graph display and pressing the left mouse button. This will display the menu
shown below.
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5. The editing functions that can be carried out from this menu are:

a. Remove — allows part of the timing profile to be cut out and disposed of or to retain part of the profile and dispose of the
rest. One use of this feature is to extract a short part of the profile to allow it to be replayed to determine if it is a stressful
section of a replay which causes a Slave Clock failure.

There are two methods of delimiting the section of interest.

The first is to use the mouse. Place the cursor at the start of the section of interest then left button down and drag the
mouse to the end of the section of interest. This will highlight the area.

Zoom in X

Remove
Repeat
Copy
Paste

Modulate

Scale

Offset

Banding

Naise Floor Density

Status: Idie

Undo Last

The second way is to use markers. These are set using the Markers buttons shown on the screen below.

There are two methods of placing the markers; using the mouse and using the location. In each case both markers should
be set. These are marked on the graph as 1and 2 as shown below.

0.000111615
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To use the mouse, click the Markers button 1 or 2 and a menu will appear. Select Set Marker using the mouse then place
the cursor at the desired position and left click. The marker will appear as shown in the previous screen shot.

Enter Marker 1 ﬂ

71.428571429

To use the location, click the Markers button 1 or 2 and a menu will appear. Select Enter
Marker manually. A pop-up window will appear as shown opposite. The parameters can then
: » be entered.
Y-axis Position: I 0.000039586
Once the area of interest is selected the left mouse should be clicked and then Remove
either the Marked or Non-Marked area.
oK I Cancel |

X-axis Position:

If Marked is selected then only the area highlighted is removed and the rest of the profile retained.

If Non-Marked is selected then only the highlighted section is retained with the rest being removed of and the rest is kept.

Example of highlighted area deleted from original

Original Profile Edited Profile — with section removed

b. Repeat — allows a section of a profile to be be repeated a controlled number of times. The whole profile may be repeated
or a section repeated within the overall profile.

There are 3 sub-selections:

ﬂ All where the overall profile is repeated the selected number of times. When the All
selection is made the pop-up screen opposite is displayed to allow the repeat number to
Repeat Count: I be set.

oK I Cancel |

The range of the repeat number is 1to 9.

As an example, the following profile will have three additional repeats inserted as shown in the second screen shot.

Original Profile Edited Profile — with repeat count of three

The other two sub-selections allow parts of the profile to be repeated within the overall capture.

The selections allow the marking of the sections to be performed either using the mouse or using markers as introduced
in the Remove section.

The following illustrates the repeating of partial profile three times.
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Original profile with section highlighted using the mouse click and drag.

Original Profile After repeating three times

Copy and Paste — allow parts of the profile to be copied then inserted into a later part of the profile.

The modes for Copy are:
e All where the whole profile is copied
e Highlighted where the section identified by using the mouse click and drag is copied

o Marked where the two markers identify the section to be copied

The modes for Paste are shown below.

Zoomin X

Remove

»
Repeat 3
»

4| Replace highliahted
Replace between markers
Insert before start

Insert after end
Insert at marker Marker 1

Marker 2

Modulate

»

Scale 3
Offset 3
3

r

Banding
Noise Floor Density

Undo Last

o Replace highlighted allows the data in the copy buffer to replace the highlighted area.

o Replace between markers allows the data in the copy buffer to replace the data between the two markers. Operation
of the markers is explained in the Remove section.

o Insert before start inserts the data in the copy buffer before the start of the data.
¢ Insert after end inserts the data in the copy buffer after the end of the currently loaded data.

¢ Insert at marker inserts the data in the copy buffer at the point marked by the appropriate marker. Operation of the
markers is explained in the Remove section.

Modulate — allows sections of the data (graph) to be edited by adding a:
e Step in amplitude

e Sawtooth increase in the values

e Triangle increase in the values

The range over which this change is applied is selectable as All, Highlighted or Marked. These are set as described in
the Remove section.
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As an illustration, the following shows how to apply a step offset to part of a profile.

Original profile with section selected using markers.

11

0.000111615

Modulation Function:
¥ Step

€ sawtooth
 Triangle

Ampiitude (us): | 200]

|

The resultant profile with the 200 microsecond step.

The range of the Modulation Amplitude is 0.1 microseconds to 1 second.
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e. Scale — allows you to increase or decrease the PDV.

Scale

of the scaling is set on the pop-up screen shown opposite.
The range of the scaling is 10 — 1000%

Scale Factor (%6): | MU

0K I Cancel |

As an example, the following will have the first part of the profile scaled to 50% of its original value.

Initial profile with the highlighted section.

With the scale factor set.

Scale Factor (%): [ 501

The final result is shown below.

x
J Again, the packets to be impacted are selected from All, Highlighted or Marker. The level

59



Banding — allows the packet timings to be gathered into bands or excluded from a band of timing.
For a clearer view of the data it is recommended that the graph be viewed in scatter graph mode rather than line mode.

The scatter graph mode is selected using the Select Graph > Graph Format > Dot controls located at the right hand side
of the graph display.

The scatter graph display for Testcase 12a 16pps is shown below.

0.000110055

The data in the defined band may now be depleted or concentrated.

If Deplete > All is selected, the packets in the band are moved out by adding an offset equal to the band height to each of
the packets to be moved as shown below.
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If Concentrate > All is selected, you will be prompted for a percentage. This is the percentage of all packets in the profile
that will be concentrated into the band defined by the two markers.

The packets selected to be moved into the band are picked at random and given a randomised value within the band set.
The result will be as shown below where 50% of the packets have been concentrated into the define band.

It is possible to apply the Banding over a section of the profile by highlighting the X-axis range over which the Depletion
or Concentration is required.

For example the screenshot below shows the markers defining the band to be adjusted and the highlighting to define an
X-axis section to be manipulated.
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g. Noise Floor Density — allows the profile to be adjusted to change the density of packets to be found in the noise floor i.e.
lucky packets.
There are two dimensions that can be defined. If only a limited section of the profile is required to be adjusted, then that
section should be highlighted using the mouse click and drag as defined in the Remove section.
The band of interest is defined between the packet with the minimum delay and one of the markers. Based on the
requested %, the number of desired packets within the noise band is then calculated.
o |f there are less packets than requested, packets out with the band are linearly selected and reassigned a new random

value in between the marker and the minimum profile value.

e |f there are more packets in the band than requested then packets within the band are linearly selected and offset by
the difference between the marker and the minimum profile value.

Example 1: If you are making an adjustment across all of the packets, you need to define the top of the band using the
marker (Marker 2 in this case). This is shown below.

The Banding and the Marker are selected as shown below. Since there is no highlighting, the only choice is All i.e.
across the whole set of packets.

Zoom in X

Remove
Repeat
Copy
Paste

Modulate
Scale
Offset
Banding
T

Set % of all packets in profile below Marker 1. Set marker
using button to the right of graph

H The percentage of packets to be placed in this band is now user-selectable via the

pop-up screen.

Percent: 8EI|

0K I Cancel |
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The following shows the effect when 80% of the packets are moved into the band.

el e o
Aoahany
R st

Example 2: Where the manipulation is applied over part of the packet set using the highlighting feature.

Initial data set is shown below.

Set the marker.

R A RE
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Set the range of the area to be adjusted.

h. Undo Last — allows you to return to the data set prior to the last operation.

Note that several windows may be opened to allow cutting and pasting of parts of several profiles to provide a final
composite data set for replay. This is invoked by using the File > Import selection from the application toolbar menu.
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